
  

LOGRESSE V2 - P3STEEL

Imprimante 3D Logresse V2
Notice de montage

La Logresse est une imprimante 3D issue de la P3-Steel de 
Irobri, remaniement du design de la Twelve Pro, elle même 
basée sur la Prusa I3 de Josef Prusa. Leonardo, la première 
version de la P3-Steel fut construite en avril 2013, après que 
Irobri eut assisté à un Maker Show à Saragosse (Espagne). 
Son châssis, en tôle d'acier de 3mm d'épaisseur découpé au 
laser lui assure une excellente rigidité et limite l'utilisation de 
pièces plastiques imprimées. L'assemblage du châssis et les 
réglages sont facilités par l'emboîtement des plaques fixées 
au moyen d'écrous captifs.
La Logresse reprend tout ces avantages, avec une rigidité 
encore améliorée. Et par le dessin de pièces métalliques 
supplémentaires, notamment celles de l'axe X et du chariot, 
elle réduit encore les pièces plastiques. Elle apporte aussi 
des emplacements supplémentaires pour y loger 
l'alimentation, des électroniques variées, etc..
La Logresse est le résultat d'un gros travail collaboratif du 
LOG (Laboratoire Ouvert Grenoblois).

https://www.logre.eu/wiki/Logresse

Documentation version 1.0.3 sous licence CC BY-NC-SA 4.0
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Préambule :
Les conditions ou méthodes utilisées pour l’assemblage, la manutention, le stockage, l’utilisation ou 
l’élimination de l’appareil sont hors de notre contrôle. Pour ces raisons, Le LOG et les auteurs de ce 
document rejettent toute responsabilité portant sur les pertes, blessures, dommages ou liés de quelque 
façon que ce soit à l’assemblage, à la manutention, au stockage, à l’utilisation ou à l’élimination du 
produit

protections supplémentaires 
La mise en place de protections supplémentaires reste sous l’entière responsabilité de l’assembleur. Par 
ailleurs, dans le cadre de modifications de votre matériel visant à améliorer la sécurité, il est 
recommandé :

• d’ajouter un bouton d’arrêt d’urgence permettant de couper l’alimentation
• de créer une structure close englobant l’imprimante
• d’ajouter un détecteur de fumée 

Sécurité électrique
L’alimentation électrique que vous utiliserez doit répondre à toutes les exigences européennes en 
vigueur et doit porter l’estampillage CE. L’alimentation doit être protégée contre les surcharges et courts-
circuits et ne doit pas nécessiter de modification. La tension de fonctionnement de l’imprimante 3D est 
de 12V (très basse tension) et n’est donc pas sujette à la directive basse tension.Le câblage doit être 
réalisé en respectant les règles de l'art dans ce domaine surtout pour la partie 220V.

Risque de brûlures
La tête de chauffe peut monter à des températures de 250° et donc occasionner des brûlures en cas de 
contact avec la peau. Il est préconisé de mettre toutes informations et protections utiles pour éviter ces 
contacts.

Équipements de Protection individuel 
L'ensemble des opérations de montage nécessite le port de chaussure de sécurité. Si d'autres 
équipements de sécurité sont nécessaire cela est précisé sur chaque étape.

Le résultat final est directement dépendant de l'attention que l'on portera à chaque étape de 
montage. Pas de précipitation, de la réflexion et une bonne dose de patience sont les éléments 
indispensables au bon déroulement du montage de l'imprimante. N'hésitez pas à poster sur la 
liste du LOG toutes interrogations que vous vous posez. Précisez dans l'objet du mail 
l'identificateur [logresse]

grenoble-hackerspace@lists.hackerspaces.org
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Visserie nb

Ecrous M3 Nylstop 99

Ecrous M3 18

Ecrous M4 4

Ecrous M5 Nylstop 1

Ecrous M5 2

Ecrous M8 Nylstop 3

Ecrous M8 1

Rondelle D3 8

Rondelle D5 7

Rondelle D5z 2

Rondelle D8z 7

Vis CHC M3x8 16

Vis CHC M3x12 69

Vis CHC M3x16 6

Vis CHC M3x25 T 9

Vis CHC M3x30 2

Vis TC M3x40 T 2

Vis CHC M4x8 5

VIS CHC M4x16 2

Vis CHC M5x30 1

Vis CHC M8x30 1

Vis FHC M3x6 4

Vis FHC M3x12 16

Vis FHC M3x25 19

Vis H M4x60 2

Vis sans tête : M3-8 5

Vis TCBZ M2.5x8mm 6

Pièces nb

Bracelet 2.5-100mm 14

Coupleur 5-5 2

Courroie GT2 ou T2.5 2

entretoise D3-14 4

LM8uu 11

NEMA 17 5

Poulie GT2/T2.5 16 dents 2

Roulement 608zz 4

Roulement 695zz 2

Stubs D8-320mm 2

Stubs D8-341mm 2

Stubs D8-405mm 2

Tige filetée M5-320 2

Stubs D8-19mm 1

Goujon Moleté Entrainemt 1

Ressort 9x30mm 1

Ressort 4x18mm 5

BOM

1x bed.dxf

1x bed-support.dxf

4x end-corner.dxf

2x end.dxf

2x frame-corner.dxf

2x frame-side-corner.dxf

1x frame.dxf

1x full-top.dxf

1x left-side.dxf

1x right-side.dxf

6x rod-holder.dxf

4x x-end-5mm-bread.dxf

2x x-end-5mm-ham.dxf

8x x-end-fork.dxf

1x x-end-idler-back.dxf

1x x-end-idler-bearings.dxf

1x x-end-motor-back.dxf

1x x-end-motor-bearings.dxf

4x y-bearing-holder.dxf

2x y-idler-support.dxf

2x y-motor-support.dxf

1x y-belt-holder-clamp.dxf

2x y-belt-holder-side.dxf

1x y-belt-holder-top.dxf

4x z-motor-corner.dxf

2x z-motor-support.dxf

1x x-carriage-bearings_v2.dxf

1x x-carriage-extruder_v2.dxf

1x x-carriage-corner-fanduct_v2.dxf

1x x-carriage-corner-servo_v2.dxf

1x x-carriage-belt-support_v2.dxf

2x x-carriage-belt_v2.dxf

1x x-carriage-head_v2.dxf

Parts PLA ( à télécharger sur le wiki)

WADE

SMALL-GEAR-WADE

BIG-GEAR-WADE

IDLER-WADE

LEVER-WADE

BAR-WADE

X-SUPPORT-ENDSTOP

Y-SUPPORT-ENDSTOP

Z-SUPPORT-ENDSTOP

PROTECT-POWER

Outillage nb

Clef BTR 1mm 1

Clef BTR 2mm 1

Clef BTR 2.5mm 1

Clef BTR 4mm 1

Clef BTR 5mm 1

Clef Plate 13mm 1

Lime Plate Métaux 1

Outil à chanfreiner 1

Taraud M3 1

Foret D2.5 1
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Taraudage des perçages M3 (en rouge) :
Préliminaire : Reprendre tous les perçages avec un foret au 
diamètre de 2.5mm pour faciliter le taraudage

Tarauds M3

ÉTAPE 1 : Taraudage

X-CARRIAGE-BELT

X-END-IDLER-BEARINGS

X-END-MOTOR-BEARINGS

END x2

FULL-TOP

Foret D2.5mm

Y-BELT-HOLDER-CLAMP

X-CARRIAGE-HEAD

Serrez la pièce dans un étau. Pour démarrer le taraudage utilisez le taraud 
ébauche, c'est celui qui a le cône d'entrée le plus long. Lubrifiez 
OBLIGATOIREMENT avec une huile de coupe sous peine de casser le taraud. 
ON NE TARAUDE JAMAIS A SEC ! Maintenez à l'aide du tourne gauche le 
taraud bien perpendiculaire à la surface et tournez délicatement en appuyant 
vers le bas pour faire mordre le taraud. Faites 2 tours au moins et revenez d'un 
tour en arrière, répétez l'opération jusqu'au bout du taraud ébauche. Passez 
ensuite le taraud finition. Pour un perçage débouchant et une longueur de 
filetage de 3mm vous pouvez vous passer du taraud semi-finition.

Ébauche

 

Utilisez les EPI appropriés ( gants, chaussures 
de sécurité, blouses)
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Chanfreinage pour têtes de vis FHC (en rouge)

Foret à chanfreiner

FRAME

X-END-MOTOR-BACK X-CARRIAGE-EXTRUDER

X-END-IDLER-BACK

Attention à chanfreiner
 du bon coté!

ROD-HOLDER x 4

X-CARRIAGE-BEARINGS

● Montez le foret à chanfreiner sur une perceuse à colonne
ou à défaut une perceuse à main

● Lubrifiez avec une goutte d'huile de coupe
● Chanfreinez le perçage
● Vérifiez que vous avez suffisamment chanfreinez,

la tête de vis FHC ne doit pas dépasser la tôle

  

Utilisez les EPI appropriés ( gants, 
chaussures de sécurité, lunettes, 

blouses)
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Utilisez les EPI appropriés ( gants, 
chaussures de sécurité, lunettes, 

blouses)

ÉTAPE 3 : Alésage

Alésoir D8H7

FULL-TOP

END X2

Z-MOTOR-SUPPORT X2

Aléser les 8 perçages coloriés en 
rouge ci contre avec un alésoir 
D8H7. Les stubs doivent pouvoir 
s'insérer sans jeu 

● Montez l'alésoir sur une perceuse à colonne ou 
à défaut sur une perceuse à main

● Utilisez une huile de coupe pour la lubrification.
●  Maintenez la pièce dans un étau.
●  Alésez le perçage en faisant pénétrer l'alésoir 

jusqu'au bout. En effet l'alésoir à une très 
légère forme en tonneau et la valeur D8H7 est 
située au milieu de l'alésoir.

Cote D8H7 ici
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Clefs BTR 2.5mm et 2mm
Vis CHC M3x12mm : 40
Vis FHC M3x12mm : 6
Écrous M3 Nylstop : 46

Tôle électro-zinguée 3mm

ÉTAPE 4 :  Châssis

Attention de ne pas se 
tromper, entre les LEFT-SIDE
et RIGHT-SIDE, 
ainsi que la position du TOP

Vis FHC

Vis CHC

FULL TOP

FRAME

LEFT SIDERIGHT SIDE FRAME-
CORNER X2

END CORNER 
X4

FRAME-SIDE-
CORNER X2

FRAME

Z-MOTOR-
SUPPORT X2

Z-MOTOR-
CORNER 

X4

 

Utilisez les EPI appropriés 
pour toutes les étapes 

suivantes ( gants, 
chaussures de sécurité, 

blouses)

Assemblez les 3 pièces 
des supports moteurs Z , 
et montez l'ensemble sur 
la FRAME.

Alésage sur 
l’extérieur

Utilisez une pince à bec fin
pour positionner et maintenir
l'écrou dans son logement
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Clés BTR 2.5mm & 1mm
Vis CHC M3x25mm
filetage total: 4
Vis CHC M3x12mm : 2
Vis CHC M3x16mm:2
Vis CHC M8x30mm : 1
Vis sans tête M3x8mm:2
Écrous M3 Nylstop : 4
Rondelles D3 : 8
Écrous M8 Nylstop
Rondelles D8z : 4
Entretoises 13.5 : 4
Ou Écrous M3 : 8
Roulement 608ZZ : 1
Poulie GT2/T2.5 : 1

ÉTAPE 5 : Axe Y - 1

Intercaler 2 rondelles
sur chaque vis !

Autre montage possible
Si vous n'avez pas d'entretoises
Vous pouvez utiliser 8 écrous M3

Y-IDLER-SUPPORT X2

Y-MOTOR-
SUPPORT X2

END X2

M3x8 SANS 
TÊTE X2

POULIE T2.5 
ou GT2

ENTRETOISE X4

Roulement 
608zz

2 vis CHC M3x16mm

Ne pas se 
tromper de sens
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Vis FHC M3x6mm : 4
Vis CHC M3x12mm : 19
Vis CHC M3x30mm : 2
Écrous M3 Nylstop : 20
Bracelets plastique : 8
LM8UU : 4

Serrer les Y-Bearing-Holders avec modération !

Vis FHC 
M3x6

Vous pouvez aussi utiliser
des bracelets plastiques
 pour fixer les douilles

BED

Y-BELT-HOLDER-
SIDE X2

Y-BELT-
HOLDER-
CLAMP

Y-BELT-
HOLDER-

TOP

Y-BEARING-HOLDER 
X4

RODS D8 340mm 
X2

ROD 
HOLDER 

X4

LM8UU X4

2 vis/écrous
 M3x30mm

Vis CHC
 M3x12mm

Utilisez les 4 RODS-HOLDERS
chanfreinés

2 Vis/écrous
CHC M3x12mm

Vis/écrous
CHC M3x12mm

BELT GT2
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Courroie GT2 ou T2.5
6 ou 10mm

1.Dévisser les 2 vis CHC M3x16 qui fixent 
les Y-IDLER pour éloigner les 2 Y-IDLER 
du END ( environ 5mm)

2.Mettre en place la courroie, bien la 
positionner dans le Y-BELT-HOLDER

3.Visser la CHC M3x12 sur le Y-BELT-
HOLDER-CLAMP pour bloquer les 2 brins 
de la courroie

4.Revisser les 2 vis CHC M3x16 pour refixer 
les 2 Y-IDLER.

5.Vérifier le tension de la courroie.

6.Renouveler les étapes depuis 1 si la 
tension ne vous paraît pas correcte, en 
modifiant l’éloignement des 2 Y-IDLER. Si 
trop tendu au lieu des 5mm, choisissez 
3mm par exemple
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Vis Chc M3x16mm : 4
Écrous M3 Nylstop : 4
Écrous M5 : 2
Ou Écrous M5Hm
Lime plate métaux

Montage X-END-BREADS et X-END-HAM sur X-END-MOTOR-
BEARINGS et X-END-IDLER-BEARINGS. Aligner le bord des petites 
pièces avec le bord extérieur de la plaque. Insérer l'écrou M5 après 
avoir limé son épaisseur à moins de 3mm. Ce montage nécessite un 
peu d'ajustage et doit être effectué avec soin !

Écrou M5
Limé ou 
Écrou bas 
M5 Hm

X-END-MOTOR-BEARING

X-END-5mm-HAM X2

X-END-IDLER-BEARING

X-END-5mm-BREAD X4

ECROU M5 X2
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Vis FHC M3x25mm : 8
Écrous M3 Nylstop : 4
Colliers 2.5-100mm : 4

ÉTAPE 9 : Axe X - 2

Serrer en alternant les vis intérieures et extérieures
Ne pas serrer exagérément pour ne pas arquer les tôles !

Fixer les douilles à l'aide 
des colliers plastiques
Ne pas trop serrer pour
 ne pas déformer les douilles

X-END-MOTOR-BACK

X-END-FORK 
X4

RODS D8-405 
X2

LM8UU X2
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Vis FHC M3x25mm : 8
Ecrous M3 Nylstop : 4
Colliers 2,5-100mm : 4
LM8UU : 5

Ne pas oublier les 3 douilles

Gabarit pour régler la distance
 entre les X-END lors du serrage

Monter les 2 douilles
avec les colliers plastiques

Serrer en alternant les vis intérieures et extérieures
Ne pas serrer exagérément pour ne pas arquer les tôles !

X-END-IDLER-BEARING

LM8UU X5

X-END-FORK X4

309.6mm
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Vis CHC M3x8mm : 10
Variante fin de course rajouter :
Vis CS M3x40mm filetage total: 2
Ecrou M3 Nylstop : 4
Vis TCBZ M2.2x12mm : 2
Ressort D9 - 30mm

- Fixer les moteurs Z
- Présenter l'ensemble X
- Enfiler les barres Z
- Mettre en place les Rod-Holders Z

Fixation du
fin de course en Z

NEMA 17 
X2

RODS D8 
320MM

 X2

RODS 
HOLDER 

X2

Z-SUPPORT-
ENDSTOP

CS M3x40mm

TCBZ M2.2x12
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Tiges filetées M5x310mm X2

Coupleurs flexibles 5-5 x2Il peut être nécessaire d'interposer
du scotch standard autour de la tige filetée
 en cas de serrage défectueux

Positionner l'axe X horizontalement. Les 2 
dimensions représentées par les 2 flèches ci 
contre doivent être strictement égales.

Vous pouvez vous aider des 
2 lumières pratiquées sur le 
FRAME (coloriées en rouge 
sur la vue de détail)  pour 
mettre l'axe X horizontal
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Vis CHC M3x12mm : 6
Vis FHC M3x12mm : 5
Ecrous M3 Nylstop : 7
Bracelets 2.5-100mm : 6

5 Vis FHC

Vis FHC à monter en premier

Monter le chariot X sur les 3 douilles à l'aide des bracelets plastiques

X-CARRIAGE-
BEARINGS

X-CARRIAGE-EXTRUDER

X-CARRIAGE-HEAD

X-CARRIAGE-
CORNER-
FANDUCT

X-CARRIAGE-
CORNER-SERVO

X-CARRIAGE-
BELT-SUPPORT

X-CARRIAGE-BELT
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Vis CHC M5x30mm : 1
Vis CHC M3x8mm : 3
Ecrou M5 Nylstop : 1
Rondelles D5 : 7
Rondelles D5z : 2
Vis sans tête M3x8 : 2
Roulements 695ZZ : 2
Ou SMF115ZZ : 2
Poulie GT2/T2.5
Clef BTR 4

NEMA 17

BELT T2.5 or 
GT2 VIS SANS 

TETE M3x8

695zz x2 PULLEY T2.5 
ou GT2

2 rondelles D5

3 rondelles D5

3 vis CHC 
M3x8mm

Tendre la courroie en déplaçant 
horizontalement la vis M5x30 dans la 

lumière, finir le réglage en faisant pivoter 
le moteur autour de la vis du haut.

2 rondelles D5z

Les roulements 695 
peuvent être 
remplacés par des 
roulements épaulés 
SMF115zz



  

LOGRESSE V2 - P3STEELÉTAPE 15 : Préparation lit Chauffant

LED CMS: 2
Résistance CMS 1K: 1
Thermistance100K
Fil électrique 1mm², 2mètres
Ruban Kapton ( polyimide)

Souder les 2 LED tête bêches
et la résistance de 1K

Souder 2 fils de longueur 80cm 
(section mini 1mm²) , ne pas hésiter 
à charger en soudure, le courant est 
supérieur à 10A

La thermistance doit juste affleurer

Utiliser du Kapton pour fixer la thermistance sur le recto du bedCoté LED
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Montage du 
support sous le 
PCB, 2 vis FHC 
M3x12 et 2 
écrous M3 
Nylstop

Vis FHC M3x25mm : 3
Vis FHC M3x12mm : 2
Écrous M3 Nylstop : 5
Ressorts D4-18mm : 3

Fils thermistance et chauffage

BED-SUPPORT
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Pour l'assemblage de la tête chauffante se référer à la documentation constructeur : 
E3D : http://wiki.e3d-online.com/wiki/E3D-v6_Assembly
J-HEAD : http://reprap.org/wiki/J_Head_Nozzle#Assembly

Monter la buse chauffante à l'aide de la 
fourchette X-CARRIAGE-HEAD et des 2 vis FHC 
M3x12mm.
Attention ce montage n'assure pas complètement 
la fixation de la buse, il peut être normal d'avoir 
du jeu. C'est  l'extrudeur dans l'étape suivante 
qui assurera le rôle de maintien.

Avec l'E3D en filament diamètre 1.75, laisser dépasser le PTFE jusqu’à la molette 
d’entraînement. Cela nécessite  un alésage de 4mm sur la partie basse de l'extrudeur et 
le design particulier de l'extrudeur wade en téléchargement sur le wiki.

http://wiki.e3d-online.com/wiki/E3D-v6_Assembly
http://reprap.org/wiki/J_Head_Nozzle#Assembly
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Vis CHC M3x8mm : 3
Écrou M3 : 1
Écrou M8 : 1
Écrous M8 Nylstop : 2
Vis sans tête M3x8mm:1
Rondelles D8Z : 3
Goujon moleté : 1

ÉTAPE 18 : L'extrudeur Wade-1

Le moletage doit être situé bien en 
regard du passage du fil

Écrou M3

Vis sans tête M3x8

608 ZZ x2

Ecrou M8 Nylstop

3 Vis CHC M3x8mm

Écrou M8

Ecrou 
M8 
Nylstop

2 
Rondelles 
D8Z Goujon M8 

Moleté

Nema 17

608zz X2

WADE (PLA)

Pour assurer un bon maintien du pignon, il 
faut absolument réaliser un méplat sur l'axe 
du moteur. Maintenir l'axe dans un étau et 
utiliser une lime pour faire ce méplat

SMALL-GEAR-WADE

BIG-GEAR-WADE
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L'écrou M3 est situé du coté de la 
tête de vis

Montez le roulement sur le stub 
et clipsez au besoin à l'aide 
d'une pince le stub dans son 
logement

608zz

2 vis H M4x60mm
et 2 ressorts

2 écrous M4

608zz

2 ressort D4x18mm

Stubs 
D8x19mm

IDLER-WADE (PLA)

NEMA 17
LEVER-WADE (PLA)

BAR-WADE 
(PLA)

Vis H M4x60mm : 2
Vis CHC M3x25mm complet : 1
Écrous M4 : 2
Écrou M3 : 1
Stubs D8 x 19mm
Ressorts 4x18mm : 2
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Vis CHC M4x16mm :2
Écrous M4 : 2

Utilisation 2 CHC M4x16mm,
Tête en bas, écrous M4 dans le wade sur le dessus

Montage de l'extrudeur sur le chariot.
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Vis TCBZ M2.5x8mm : 4
Vis Chc M3x12mm : 1
Écrou M3 Nylstop : 1

2 vis TCBZ M2.5x8mm

Clippez le support plastique X-SUPPORT-
ENDSTOP sur le stub et glissez le à fond vers 
la gauche
Équipez le contacteur avec 2 fils soudés sur 
les 2 plots extérieurs et installez le à l'aide des 
2 vis TCBZ. N'hésitez pas à couper les 2 vis si 
elles sont un peu longues. Les 2 fils seront 
connectées sur la carte de commande aux 
entrées Endstop Signal et +

X-SUPPORT-ENDSTOP

Un boulon M3x12mm

Y-SUPPORT-ENDSTOP

Contacteurs x2

X

Y
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Vis CHC M4x8mm : 5
Vis CHC M3x12mm : 1
Vis FHC M3x12 : 3
Écrous M3 : 4

2 FHC M3x12

Alimentation fixée au dos
 par 4 vis CHC M4x8

PROTECT-POWER fixé
 par 1 vis CHC M3x12 sur 
le LEFT-SIDE,1 vis FHC 
M3x12 sur le FRAME  et 2 
écrous M3

Power_supply_RSP-320-12
Ou Power_supply_PDF-320-12

Rocker Switch KCD1-2

IEC320-703W

PROTECT-POWER

Réalisez le câblage avant de mettre le protect-power

Le montage s'effectue sur 
le LEFT-SIDE
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Vis CHC M3x25mm filetage total: 4
Écrous M3 : 4
Entretoises plastiques : 4

Le montage s'effectue sur le RIGHT-SIDE.
Il peut être utile de monter une plaque par 
dessus la carte de commande permettant 
la protection et le montage d'un ventilateur 
favorisant le refroidissement des drivers de 
pilotage des moteurs pas à pas.
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Exemple de câblage pour une carte de 
commande de type Ramps

Quelques préconisations pour le câblage :

● Évitez les câblages en l'air, pour tester rapidement l'imprimante, c'est 
souvent l'assurance de faire n'importe quoi. Les premiers tests doivent 
être réalisés câblage terminés et propres.

● Respectez les orientations des fils : les positionner toujours 
horizontalement et/ou verticalement , JAMAIS en oblique.

● Choisir des couleurs de fils pour l'identification des fonctions, n'utilisez 
surtout pas la même bobine de même couleur pour l'ensemble des 
connections.

● Si vous avez besoin de raboutez 2 fils électriques, soudez et isolez 
bien l'épissure avec de la gaine thermo.

● Fixez les câbles à l'aide de bracelets plastiques sur les Frames. Ne 
serrez pas tout de suite les bracelets, laissez de l'espace pour passer 
d'autres fils avant de serrer les bracelets. Ce serrage doit être réalisé 
à la fin du câblage

● Vérifiez bien la longueur des fils, surtout pour ceux qui vont vers 
l'extrudeur. Ils ne doivent en aucun cas bloquer la mobilité de celui ci.

● Utilisez les diamètres appropriés pour le câblage, au moins 1mm² 
pour les chauffage de l'extrudeur et du bed, 

● Pour la partie 220V, respectez la couleur des fils, Bleu pour le neutre, 
brun ou rouge pour la phase, vert pour la terre. Utilisez uniquement un 
interrupteur bipolaire.

● Soignez le câblage des moteurs, un fil moteur de débranché sous 
tension, c'est la destruction immédiate du driver.

● Les moteurs pas à pas sont bipolaires, ils sont constitués de 2 
bobines 1 et 2 alimentées respectivement par 4 fils 1a 1b pour la 
bobine 1 et 2a 2b pour la bobine 2. pour identifiez les fils des bobines 
vous pouvez utiliser un ohmmètre Une autre méthode consiste à 
court-circuité une bobine. Quand celle ci est court-circuitée le moteur 
tourne difficilement. Reliez ensuite les bobines aux drivers sur la carte 
de commande, peu importe le sens des bobines. Une inversion d'une 
bobine fait tourner le moteur en sens inverse, on réglera cela dans le 
firmware.

● Installez les jumper sous les drivers pour faire
fonctionner les moteurs au1/16 de pas. Se référer
à la documentation de la carte et des drivers. 
Pour la carte Ramps et des drivers à base de 4988
il faut installer les 3 jumpers
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I - Préparez votre informatique (PC windows, linux, Mac) :
Installez les logiciels suivant :

● IDE Arduino version 1.0.6 - https://www.arduino.cc/en/Main/OldSoftwareReleases#previous 
● Repetier Host dernière version - http://www.repetier.com/download-now/ 

Se referez à la documentation de la carte pour installer le driver de la carte de commande, lors 
de l'installation du driver, notez bien  la valeur du port COM utilisée. Par exemple pour la carte 
Ramps utilisant un arduino Mega dans un environnement Windows : connectez la carte par le 
câble USB à votre ordinateur, le système Windows va rechercher le meilleur driver, 
« normalement » il ne va pas le trouver, il vous faudra indiquer le chemin. Le driver est 
disponible dans le répertoire driver de l'installation du logiclel IDE Arduino que vous avez installé 
précédemment.

II – Préparation du Firmware
Pour cette étape ne pas alimenter la carte de commande, La partie logique de la carte sera 
uniquement alimenté par le port USB

Téléchargez la dernière version du firmware Marlin ( d'autres firmware sont disponibles, 
Repetier, Sprinter, Teacup, Smoothie, les manipulations sont très proches)  
https://github.com/MarlinFirmware/Marlin   utilisez le bouton  Download Zip.
Ouvrez le logiciel IDE Arduino et sélectionnez à l'aide du menu File le fichier marlin.ino du 
répertoire ou se trouve le firmware précédemment téléchargé.
Sélectionnez à l'aide de l'onglet le fichier configuration.h. Quelques variables sont à modifier ou 
à retenir dans ce fichier avant de télécharger le firmware sur la carte.

● #define BAUDRATE 115200 c'est la vitesse du port série qu'il faudra spécifier par la suite. A 
retenir.

● #define MOTHERBOARD BOARD_ULTIMAKER . Précisez à l'aide de cette ligne la carte de 
commande que vous utilisez. Pour avoir la désignation exacte de la carte, ouvrez le fichier 
board.h qui contient la définition de toutes les cartes prises en charge par ce firmware. Par 
exemple pour une carte Ramps pilotant un extrudeur et un bed modifiez la ligne de la 
manière suivante : 

#define MOTHERBOARD BOARD_RAMPS_13_EFB

● #define TEMP_SENSOR_0 1 si vous utilisez une thermistance 100K de marque EPCOS 
pour l'extrudeur

● #define TEMP_SENSOR_1 0 si vous n'utilisez pas un biextrudeur
● #define TEMP_SENSOR_2 0  not used
● #define TEMP_SENSOR_BED 11 si vous utilisez une thermistance 100K 3950 pour le lit 

chauffant
● #define DISABLE_MAX_ENDSTOPS  dé-commentez cette ligne si vous n'utilisez pas les 

capteurs fins de course MAX
● #define DEFAULT_AXIS_STEPS_PER_UNIT   {80.0,80.0,4000.0,760}  spécifiez ces 

valeurs par défaut que nous expliquerons plus loin

Précisez maintenant à l 'IDE Arduino le type de carte  que vous utilisé en ouvrant le menu 
->Tools-> Board . Pour la carte Ramps, par exemple, sélectionnez : Arduino Mega 2560. Se 
référer à la documentation de la carte si le nom de celle ci n’apparaît pas dans la liste. Choisir 
ensuite à l'aide du menu Tools→Serial Ports le numéro du port COM qui est défini pour la liaison 
avec la carte via USB ( la carte doit être connectée par le port USB pour que ce port apparaisse. 
COMxx ).
Compilez et téléchargez le firmware dans la carte en utilisant le menu ->File->Upload

ÉTAPE 25 :  Premier pas

III – Premier dialogue avec la carte :
Une fois toutes les opérations précédentes effectuées avec succès ! Basculez 
sur le Serial Monitor de l'EDI Arduino -→Tools-→Serial Monitor
Réglez la vitesse du port en bas a droite ( 115200 bauds). Et sélectionnez 
carriage return sur l'onglet a gauche. Normalement la carte doit parlez un peu ! 
Nous allons lui envoyer quelques gcodes à l'aide du champ texte situé en haut 
du Serial Monitor et du bouton Send (n'envoyez que M115 le reste décrit la 
commande) :
M115 Get Firmware Version and Capabilities
M119 Get Endstop Status
Si le firmware renvoi :
Reporting endstop status
x_min: open
y_min: open
z_min: open
Et qu'aucun fin de course est activé, le réglage booléen des fins de course est 
opérationnel. Si vous obtenez l'inverse Triggered au lieu de Open il faut 
inverser dans le firmware les variables : 
const bool X_MIN_ENDSTOP_INVERTING = true;
const bool Y_MIN_ENDSTOP_INVERTING = true;
const bool Z_MIN_ENDSTOP_INVERTING = true;

false à la place de true
Recompilez et téléchargez le firmware. Vérifiez de nouveau le statut des 
Endstop avec la commande M119. Vérifiez alors leur fonctionnement. 
Maintenez un fin de course activé et relancer la commande M119. Vous devez 
avoir si c'est le fin de course en X d'activé :
x_min: TRIGGERED
y_min: open
z_min: open

Testez chaque fin de course. .
Vérifiez le fonctionnement des capteurs de températures, envoyez la 
commande Gcode 
M104 Get Extruder Temperature
 ok T:23.8 /0.0 B:23.0 /0.0 T0:23.8 /0.0 @:0 B@:0 T correspond à la température renvoyée 
par le capteur de l'extrudeur, B c'est le lit chauffant (Bed). Ici l'extrudeur est à 
température ambiante 23°8, même chose pour le Bed.
Cette première étape effectuée nous allons pouvoir tester la carte alimentée 
sous 12V. Mais avant cela positionnez chaque potentiomètre situé sur les 
drivers de commande des moteurs pas à pas à 1/4 de leur position Max. 
Tournez délicatement avec un tournevis isolé électriquement ( en céramique) 
chaque potentiomètre à fond dans le sens inverse des aiguilles d'une montre, 
ne pas forcez sur la butée et ensuite tournez d'un quart de tour dans le sens 
horaire.

https://www.arduino.cc/en/Main/OldSoftwareReleases#previous
http://www.repetier.com/download-now/
https://github.com/MarlinFirmware/Marlin
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I – Mettre sous tension :
Branchez la Prise 220V de votre alimentation sur le secteur, pas de fumée, vous pouvez continuer. 
Mettre l'interrupteur sur la position ON, la carte est maintenant alimentée. Pas de fumée, vous 
pouvez continuer ! Si vous constatez des vibrations importantes sur un moteur, à l'aide du 
tournevis céramique (isolé électriquement) diminuez le courant qui parcourt ce moteur en tournant 
le petit potentiomètre du driver, celui que nous venons de régler, dans le sens inverse des aiguilles 
d'une montre, pour baisser le courant, jusqu’à ce que les vibrations cessent.

II – Premier mouvement X,Y et Z :
Nous allons utiliser encore ici  le Serial Monitor de l'IDE arduino. Cela permet de mémoriser les 
principaux Gcode utilisés par l'imprimante. Vous retrouverez sur le site Reprap l'ensemble de ces 
gcodes avec leur description   http://reprap.org/wiki/G-code
Assurez vous que les 3 axes X,Y et Z soient situés au milieu de leur débattement, pour éviter 
d'arrivée en butée lors des mouvements à venir. Nous allons vérifier le bon sens de déplacement 
des 3 axes.
Tapez la commande suivante dans le Serial Monitor :

• G1 X50.0 F200 l'axe X doit se déplacer de 50mm dans le sens positif avec une vitesse de 
200mm/min, donc en s'éloignant de son capteur fin de course Xmin.

Si l'axe X s'éloigne du capteur fin de course, vous avez gagné ! Sinon notez qu'il faudra inverser le 
mouvement dans le firmware pour X
Faites de même pour Y et Z

• G1 Y50.0 F200
• G1 Z20.0 F100      // on a baissé la vitesse pour l'axe Z

Vous avez un ou plusieurs axes inversés, nous allons donc voir dans le firmware comment régler 
ce problème. Notez que vous pourriez aussi inversez les fils sur une bobine d'alimentation du 
moteur, mais après avoir soigné les câblages qui aurait envie de tout défaire !
Voilà les 3 variables dans le firmware à régler , fichier configuration.h :

• #define INVERT_X_DIR true    
• #define INVERT_Y_DIR true   
• #define INVERT_Z_DIR true  

Changer l'état boolen de la variable incriminée false or true.
Sauvegardez, compilez et téléchargez. Re-testez les mouvements.  Il est temps maintenant de 
tester les capteurs fins de course en lançant des commandes de « homing » :

• G28 X //Le chariot X se déplace jusqu'au fin de course et défini cette position  X=0
• G28 Y
• G28 Z //Faites attention à ce que la buse ne touche pas le plateau pendant ce 

mouvement. Coupez l'alimentation pour arrêter le mouvement si besoin et réglez le 
capteur

III – Calibration des axes X,Y et Z
Cette étape indispensable permet de s'assurer qu'un commande de déplacement de 100mm 
entraîne bien un déplacement de 100mm de la buse. Pour cela il faut régler la ligne suivante du 
fichier configuration.h du firmware :
#define DEFAULT_AXIS_STEPS_PER_UNIT   {80.0,80.0,4000,760}
Chaque paramètre correspond au nombre d'impulsion qu'il faut envoyer au driver pour que l'axe 
se déplace de 1mm. Le premier paramètre 80.0 c'est le nb d'impulsion à envoyer au driver X pour 
que l'axe X se déplace de 1mm. Le deuxième pour l'axe Y , le troisième Z et le quatrième 
l'extrudeur que nous réglerons dans les étapes suivantes.

Un peu de math !  Les moteurs utilisés sont généralement des moteurs 200 pas par 
tour ( 0.9° d'angle) que nous faisons fonctionner en 1/16 pas. Donc pour faire 
effectuer un tour complet au moteur il faut envoyer 200*16=3200 impulsions au 
driver. Si vous utilisez une poulie GT2 de 20 dents (pas 2mm)  pour l'axe X et Y , 1 
tour complet de la poulie entraîne une translation de la courroie donc de l'axe de 
20dents*2mm= 40mm. Donc pour faire une translation de 1mm il faut envoyer 
3200/40 = 80 impulsions, c'est le paramètre à spécifier dans le firmware. Pour l'axe 
Z, une rotation d'un tour du moteur entraîne une translation correspondant au pas 
de la tige filetée ici M5, 0.8mm. Donc pour faire 1mm il faut 3200/0.8 =4000 
impulsions
#define DEFAULT_AXIS_STEPS_PER_UNIT   {80.0,80.0,4000.0,760}
Vérifiez avec un pied à coulisse la calibration, en générant un déplacement de 
100mm sur chaque axe et en mesurant précisément ce déplacement.

● G1 X100 F200

IV – Réglage fin du courant dans les moteurs :
C'est une étape importante, car elle conditionne beaucoup le bon fonctionnement de 
l'imprimante. Un gros pourcentage des problèmes rencontrés viennent souvent de 
ce réglage.
Le potentiomètre situé sur le driver permet de régler le courant circulant dans le 
moteur. 

● Si ce courant est trop élevé, le moteur chauffe , ses performances chutent, 
mais le driver se met aussi à chauffer et au dessus d'une certaine température 
le driver se met en sécurité, l'axe ne bouge plus pendant cette période de mise 
en sécurité qui peut durer qqs millisecondes, temps nécessaire au 
refroidissement du driver. C'est pourquoi il est conseillé de mettre un radiateur 
sur la puce du driver, et d'utiliser un ventilateur pour forcer le refroidissement.

● Si ce courant est trop faible, le moteur exerce un couple faible, qui peut 
entraîner un saut de pas. Malgré l'impulsion le moteur n'arrive pas à tourner. On 
peut rencontrer ce genre de problème si on utilise une forte accélération qui 
nécessite un couple important, ou si les frottement des guidages sont trop 
importants.

On voit que dans les 2 cas le moteur a sauté des pas, on perd donc la position 
absolu de l'axe, ce qui entraîne des décalages d'impression sur les pièces.
Pour régler de manière précise ce courant il suffit de régler la tension Vref , tension 
entre la partie mobile du potentiomètre et la masse. Pour calculer cette tension se 
référer à la page Reprap http://reprap.org/wiki/Pololu_stepper_driver_board
Pour roder les axes X et Y vous pouvez copiez n fois ce petit bout de programme

● F1000
● G1 X20 Y20
● G1 X170 Y170

Et vérifiez qu'il n'y a pas de perte de pas. N’hésitez pas à augmenter la vitesse avec 
la commande F

http://reprap.org/wiki/Pololu_stepper_driver_board
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I – Utilisation de Host Repetier :

Jusqu’à présent nous avons utilisé le Serial Consol pour dialoguer avec la carte. Pour faciliter ce dialogue nous allons maintenant utiliser Repetier Host qui 
est un logiciel graphique qui facilite le dialogue avec la carte de commande.
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